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1 A\ CAUTION

Moving platen, T-shirt tray and covers can cause bodily injury.
Keep body parts away from moving parts.

A\ VORSICHT

Druckplatte, T-Shirt-Ablage und konnen
Halten Sie Kérperteile von beweglichen Teilen fern.

A\ ATTENTION

Gardez les parties du corps éloignées des piéces mobiles.

Déplacement du plateau, chargeur T-shirt et couvercle peut blesser le corps.

/\ATENCION

Mantenga las partes del cuerpo alejadas de las partes méviles.

Moviendo la placa, la bandeja de camiseta y las cubiertas pueden causar una herida personal.

A\ ATTENZIONE

Tenere le parti del corpo lontane dalle parti in movimento.

Tavoletta mobile, il ripiano per la T-shirt ed il carter potrebbero causare infortuni.

AEE
TSFURTY YR AEENN-EDBCFEEESH, FHET D, BHHEIHOHERTE, 7
AZE®E
FREER. THF EEEBRMHG. 5 EEIET
/\ CUIDADO

Movimento do cilindro, prato de impress&o e tampas podem causar lesbes corporais.

BEERCINT, AUBET I EDBD,
BREVD, SHT>THON/—ERTTLE,

A GEFAHR

Hochspannung verletzungsgefahr!

A DANGER A DANGER

Hazardous voltage will

switch and wait Sminutes | aus und warten sie 5 minuten, linterrupteur et attendre 5
before opening this cover.| bevor sie diese abdeckung 6ffnen. | minutes avantd'ouvrir le capot.

MESRERS, 2SBRG.
FELIERERIR § HH/E, BARER.

Un voliage non adapte provoguel

ABRER

A PELIGRO

Un voltaje inadecuado puede
provocar las heridas. Apagar el
interruptor principal y esperar 5

minutos antes de abri esta cubierta

>PS< )

A PERIGO

A tensdo é perigosa e pode causar lesdes.
Desligar a corrente eléctrica e esperar pelo
menos 5 minutos antes de abrir esta tampa.

>Ps<

/A CAUTION

Take care not to let the liquids come into contact with
your eyes or onto your skin,
otherwise inflammation can result.

/A ACHTUNG

Vermeiden Sie den Kontakt der Flissigkeiten mit
Augen und Haut, sonst kdnnen diese gereizt werden.

/A ATTENTION

Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation.

/\ ATENCION

Tome el cuidado para no permitir que los liquidos
toquen los ojos ni en la piel,
de otro modo inflamacién puede resultar.

A\ ATTENZIONE

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.

AE B
KIEERCT TN DD,
(DB DRREN B PRAICH RN &S CTHTE,
/A\ CUIDADO

Tome cuidado para nao deixar que os liquidos entrem
em contato com os olhos ou a pele, caso contrario,
podera ocorrer inflamagéo.

A\ 2
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/\ CAUTION

A\ VORSICHT

©0

Do not drink the liquids under
any circumstances, as they can
cause vomiting and diarrhea.
Take care not 1o let the liquids
come into contact with your

Bitte trinken Sie nicht die
Flussigkeiten, da die Gefahr von
Erbrechen und Durchfall besteht.
Vermeiden Sie den Kontakt der
Flussigkeiten mit Augen und
Haut, sonst kdnnen diese gereizt
werden. Halten Sie die
Flissigkeiten von Kindern fern.

eyes or onto your skin,
otherwise inflammation can

/A\ ATENCION

result. Keep the liquids out of
the reach of children.

A\ ATTENTION

Ne pas avaler les liquides
d'aucune maniére, car ceci
pourrait entrainer
vomissements et diarrhée.
Veuillez a ne pas laisser ces
liquides étre en contact avec
les yeux ou la peau, car ceci
pourrait entrainer une
inflammation.

Maintenez les liquides hors de
portée des enfants.

No tome los liquidos en cualquier
caso, como pueden causar
vomitar y diarrea. Tome el cuidado
para no permitir que los liquidos
toquen los ojos ni en la piel, de
otro modo inflamacion puede
resultar. Mantenga los liquidos
fuera del alcance de nifios.

AEE

TR B ST BAEMEN B D1V IR
EORGBBERE RN E RIEZIRRT
TUEMN B D, 1 VI BREDRGEAN
BPRECHIBRNLSICTDITE,
FHROFOBNRNETDICELTE,

A\ ATTENZIONE

A E B

Non bere per nessun motivo i
liquidi poiché possono causare
vomito e diarrea.

Evitare il contatto di questi

@0

liquidi con gli occhi e con la
pelle poiché potrebbero creare
infiammazioni.

Conservare i liquidi lontano
dalla portata dei bambini.

RS BIES . [l A7 ARE
SR RS K AR TR AR
SRR AT IR |
BHERELEE AN

/A CUIDADO

Nao beba os liquidos sob nenhuma
circunstancia, pois eles podem
causar vomitos e diarréia. Tome
cuidado para nao deixar que 0s
liquidos entrem em contato com os
olhos ou a pele, caso contrario,
poderé ocorrer
inflamagao.Mantenha os liquidos

fora do alcance das criangas.

M Deposite in compliance with your local
regulations.

W Gebrauchte es gemaB ortlichen Richtlinien
entsorgen.

M Jetez conformément a la reglementation
locale en vigueur.

M Deseche siguiendo la normativa local.

M Smaltire in conformita alle normative locali.
M Deposite em conformidade com os
regulamentos locais.
W i3 D FES (CHE > TREEL TIES L,
W SRR EER.

S el ]
NP
| — [[’m =
Use Before

A\ CAUTION

©0

Take care not fo let the liquids come into contact with your eyes or onto your skin,
otherwise inflammation can result. Keep the liquids out of the reach of children.

and diarrhea.

Do not drink the liquids under any circumstances, as they can cause vomiting

Use pliers to open the seal cap.

Opening the seal cap with bare hands may cause injury.

Heavy drum could cause injury or backache.
Do not lift or move the drum without mechanical assistance.

| Deposite in compliance with your local regulations. Do not overtighten.
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FEMESIRETN: off
pa=0:. 3 0.06 cc =
BEHE: 0.20 cc
s 13 : " 00%

87E [T weamvk =] I B8R

(6) FREMRIFAEINCIFA], [PRAFIARXG 31t

A5 PR S FR A R R £

(1) ZMEEH RS, K CorelDRAW HHIIH G L4 "GT_Colors xml"F1"GT_Tshirts. xml"{# 472 PC .
(2) MEHAFHIEFWindow]>[Color Palettes]>[Open Palette].
(3) &F M4 "GT_Colors.xml"FI"GT_Tshirts.xml".

(%]
o BN HKS. Pantone SEHIBEAEA B A . 75 i A T N AT BEANH -

88



QAT BNt

LB
(1)  MESEHALFik#[Bitmaps]>[Convert To Bitmap].

(2) ‘¥4[Color mode]¥ & N[RGB Color].
(%]
o HAAMIMESTEIN, H[Anti-aliasing] I IEHEREES

Convert To Bitmap X

Resolution: | 300 '-: dpi

Colormode: |RGB Color (24-bit) -

Options
[¥] Anti-aliasing
[¥| Transparent background

Uncompressed file size: .33 MB

7 . (0] 4 Cancel

(%]
o EDBEATERHLIRANELT P BAE A RS, [Page Layout]sf i HE4E [Settings from printer].
Salhti £ AR ST AE[Page Layout] o B B se FE AR
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BREFT Nl
¥z E i RGB=255 B#l RGB=254
RGB=255 iH A A& . f 7 RGB=255 [rIF 5 AN i & .
FTENA T, 15163 RGB=255 [#[X 1) & # )y RGB=254.
T LR 77T B e
(1)  MEEHAirhig i [Effects)>[Adjust]>[Replace Colors].
(2) sS[Originall) N3, 7E[Replace Colors] % &y RGB=255.

Replace Colors X

moa aqam

Before

Range

Original New

[—|

N

50
R Q255
G 255
B: Q255
i
o
~ Pr v . Cancel

RGB=255

(3) HHFEEERJT i [New color]i% B & RGB=254,
(4) #%A[Single color], i [OK]#%4l.

Replace Colors X

Range

Original New

Single color

Hue

Saturation

Lightness

| Preview Reset

(%]
o REHEN, RSP E NN RGB=254.
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4-3-2. ffH Adobe Photoshop i}

Hilid Photoshop $447 P #4F .
o PithixE

TR G EPUT LA TR0
o AUEATEIEE (ARX6 )
o MEFISCHBAE R R AR
o 4 RGB=255 ##:}y RGB=254

[Z%]

o EBOH CMYK B, J@id ASE A~ ik Image]>[Mode##y RGB 1 #(sRGB). @i A=A [Image] >[Adjustments] 1]
SRR, BB T IR P i 5 e R
- fEH Al BATE RN, =441, REER >>P17"
- JUEFR OB EMSRIFTENEIER, ="4-5-7. & EEFT >>P.128"

o AHlAHEREEH Photoshop CC. it Photoshop CC 1B 7R i .

B E
(1)  MSEHA:Fi%$#[Edit] >[Color Settings].

(2) [Color Settings]HHTLA N HE.
[Working Spaces]
e [RGB]: [sRGB IEC61966-2.1]
[Conversion Options]
e [Engine]: [Adobe(ACE)]
e [Intent]: [Relative Colorimetric]
[Color Management Policies]
e [RGB]: [Convert to Working RGB]
e [CMYK]: [Convert to Working CMYK]
e [Gray]: [Convertto Working Gray]
e  [Profile Mismatches]: i%H[Ask When Opening]. i%H[Ask When Pasting]
e [Missing profiles]: i&H[Ask When Opening]

Color Settings X

tura:

Blen Using Gamma:

% Ask When Pasting Blend Te: ng Gamma:

@
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SIRFITENEIE (ARX6 3X14)

LA ARX6 2o EUG B AT BB B A A AT BN ORA7
Aol ARXG SCIFJE AT AT LA T AT

] LR S B AN TN B R B NS iR AT
A AANZERE PC M\ USB f7-4ifi 25 ELHEEAT .

(%]

™

(2)

©)

(4)

ARX6 MAHTRES R EUE . 1 F e BUEEHR (R e -

IS R R FPHEA IR [Print to filelfis & I BTG e SOt I S U AT BT Fe 2 . 1B ST ENHLEREN 25" Brother GTX-6
FileOutput”.

MR BB AFT EM AR AR, ="5-6-2. MR HIFET RIZHT ENEdE >>P.162"

MEE A kR File] >[Print]. PC —ffd FHIK4TENHLA"Brother GTX-6"%"Brother GTX-6 FileOutput"i, HERi % &
NG

BATLL N CE.

e  [Color Handling]: [Printer Manages Colors]

¢ [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup

Printer Brother G

) Description

Position and Size
nritin

M[Printer]-Ri% #3044 H F "Brother GTX-6 FileOutput".
(%]
e ¥[Printer]¥% & }"Brother GTX-6", T ENHHE &% EFTEML.
K [Printer] % & N'"Brother GTX-6 FileOutput"i}, FTENEHELL ARX6 SCAHRAE .

7E[Print Settings] & BT EIHLIREIFET -
o (R BIITENSHER, ="4-4-1. FEITENLIKEIFET >>P.102"
o JUFHPR AR Gl SR VAR, =4-5-1. WEITEINLIRSIFET >>P.120"
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(5) F& F[Print]/5 SR LA R XHEHE. s [PRAT].

(%]
o HAERE) L BRI TEL .

= O X

Y3t IMG_1404
B 21/10/2021 13:00
FEFAMAE: 14x16
(41 1200dpi x 1200dpi
A hiER: - +B84uh

M3 5

AL 3

ENGIESRA: x1

a4 b 00 %
TROREIRETS: Off
H5—OIEE I AENR: Off

§¥58..
A=A 000 ce
814 0.00 oo
ENBY: 14k
FTLA Y- [Tweomyk ~] I 874
= we L A

(6) FREMRIFAEINCIFA] [PRAFIARXG 31t
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Aok FH SR P A R AR

(1) HREHTER, ¥ Photoshop FHIFIAEMIF"GT_Colors_T.ase"{i#f7-% PC H.
(2) MRz Window]>[Swatches].

(3) M=, I3,

(%]
o A HKS. Pantone SFBIEFEA MR T IBIE . 75U AT ENEE i REAE .
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# RGB=255 &y RGB=254 K

RGB=255 {5 iE I . 8 RGB=255 I3 /0 AN HijH 52

TEN A, 5%k RGB=255 X5 &4y RGB=254.

T CA R 5757 B e

(1) ESEERA I [Layer]>[New Adjustment Layer]>[Selective Color] G &# K2
(2) AT HERE N 20%If HT[0K].

New Layer X

Nar Se 0K

Use Previous Layer to Create Clipping Mask
Color: [X]None

Mode: Normal Opacity: 20|

Cancel

(3) fE[Selective Color] i TLA Rk E .
e [Colors]: [Whites]
e [Black]l: 1%
o iEA[Absolute]

s

s

Relatve ) Absolute

[Z%]

. n EFTE, K RGB=255 By RGB=254 [{177i%, 1X[Color mode]’A[RGB Color]iI[8 bit]i 7] .

o il Photoshop ¥ RGB=255 ¥ Jy RGB=254 f{jah{F L F"SolidWhite.atn" (sl #iIFHH (=-"4-6-2.44"RGB=255"# #i )y
"RGB=254" ({{ Photoshop) >>P.131"). J<T-fdiff /5%, &S U8 Photoshop I35,
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4-3-3. f&F Adobe lllustrator i

THIE llustrator $447 PA M 44F .
o PithixE
o FIIBHCMF

TR T BT DL A
o CUESTENEIE (ARX6 X1
o[RS RE bR

[Z%]

o NEHREUEHERAESTENVEE N, EURHURE KBS P, 5T UL M.
- JESIRTER PC — R AT ENPLE E 4" Brother GTX-6"5{"Brother GTX-6 FileOutput".
- JEjd"Brother GTX-6 FileOutput"+T EFHLIRBNFR 4 Hh SO @I TRYEHAIA o

o BN CMYK T, i5#5 Bl{4i52\ Photoshop, iEid 32 A% [ [Image] > [Mode]##:4 RGB % (sRGB). 4, i 52\ Photoshop
DAG S g e MR BOES 4 T B LIR SR 3 o 5 e R
- fSEFH SR T ENEERY, ='4-4-11. REER >>P117"
- RS G B A BT ENEEERT, ="4-5-7. & HER >>P.128"

o AHLAHEREM Nlustrator CC. i3 Nlustrator CC 5 HA &7 i o
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Bl i B
(1)  MESEHALFiEE[Edit] >[Color Settings].
(2) Ai[More Options].
(3) NPT R E I A [OK].
e [Settings]: [Custom]
[Working Spaces]

e [RGB]: [sRGB IEC61966-2.1]
[Color Management Policies]

e [RGB]: [Convert to Working Space]

e [CMYK]: [Convertto Working Space]

e  [Profile Mismatches]: i%H[Ask When Opening]. i%H[Ask When Pasting]
e  [Missing Profiles]: £+ [Ask When Opening]

[Conversion Options]
e [Engine]: [Adobe(ACE)]
e [Intent]: [Relative Colorimetric]

Color Settings

1s are not synchronized for consistent color. To

Load...

GB: sRGB IEC61966-2.1

(: U.S. Web Coated (SWOP) v2

Convert to Working Space
MYK: Convert to Working Space

s: B Ask When Opening [ Ask When Pasting
s: [ Ask When Opening

Conversion Options
Engine: Adobe (ACE)
ntent: | Relative Colorimetric

Use Black Point Compensation

Less Options
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ITTFHCAF

(1) WEB,
e [Width]: 370 =X
e [Height]: 420 %=X
e [Orientation]: #\JA
e [Color Mode]: [RGB]
(%]
o CRTEEMEEEREAMAMERT . R RIER) 14X 16 FARIKR
- [l A A AR IIFT BN, =4-4-2. EFER T >>PA104"
- R AR AR ENEERE, ="4-5-2. iEFERRT >>P.122"

More Settings

Untitled-1
[Custom]

~
iboaras: , 1

size:  [Custom]
Width: 370 mm Units: Millimeters
Height: 420 mm Orientation: [g] [&l

Left Right

-~ S Lo IR LAY =0t
~ Umm « mm «  mm

RGB
High (300 ppi)

lode: Default
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BIEFITENEHE (ARX6 3U1F)
LA ARXG it 30t UG BE AN T B3 B A B AT BN fRAT
Al ARXG ST JE AT LAEAT DA R 44
o ALK EUREERANFT EN R B B AR IR
o AILIAEEHE PC M USB f#fifids ELAEATHN.
(%]
o ARX6 XTSRS . 1k UGB R AT o
o IEAENMHITETFHERHI[Print to file]fi5-4 AT BETCIETE E St SOt L BANY e 44
FileOutput”.
o SRR HEMFTEINUACREEERT, =5-6-2. W FFRERF AT EEHE >>P.162"

(1)  MEEALh%SFile] >[Print]>[Color Management].
(2) HTUTEE.
e  [Document Profile]: [sRGB IEC61966-2.1]

e [Color Handling]: [Let lllustrator determine colors]
e  [Printer Profile]: [sRGB IEC61966-2.1]
e [Rendering Intent]: [Relative Colorimetric]

QAT BNt

THE AT ENYLIR BN " Brother GTX-6

Print

Print Preset: Custom

Printer: Brother GTX-6 FleQutput

General

Marks and Bleed
QOutput

Graphics

Color Management diing: Let Illustrator determine colors

file: sRGB IEC61966-2.1

Rendering Intent: | Relative Colorimetric
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(3)  M[Printer]Hif #3044 tH H"Brother GTX-6 FileOutput".
(%]
e ¥[Printer]¥% & }"Brother GTX-6", T ENHHE &% EFTEML.
#[Printer]i5% & A"Brother GTX-6 FileOutput"fif, #TEIAELL ARXE SCHHR-AT

(4) fE[Advanced] T EFTEIHLIRBNFET -
o fHAHAMIMARFTEEIEN, = 4-4-1. WEITEWLIRSIFET >>P.102"

o RIRAEEAMEBNITIEYEN, ="4-5-1. WEITONIKSIFET >>P.120"
| GE=9

e Adobe lllustrator Ff, I FHFE i T EIXS T AE P AR AR 5 B AR R
MITERS EXEAE R B, AT R CyRIER s & KGR AIRCE .

(5) # F[Print)F R bA X IEHE. SR
[%]
o THIREFREJ LRI AL,

W o X
HE54: IMG_1404 70
BepEdE: 21/10/2021 18:00 a
EtRRT: 1416
SIFE: 1200dpi x 1200dpi
REEE: TR+ARRE
= 5
B 3
IERA: x 10
BEhEE: 400 %
FIREHARE: off
HENESREIN: off
PELE: 0.06 cc =
B8HE: 0.20 cc
wa 15k : * 600 %
BRE [T weomv =] I© aEsas
) o ——

(6) FREMRAFAEINCIFA], [PRAFIARXG 31t
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Aok FH SR P A R AR

(1) IZBEHEFES, B llustrator F A EHCCH"GT_Colors_T.ase"{#17 % PC .,
(2) MR IEPWindow]>[Swatches].

(3) Hili=, #&#F1=K5H[Open Swatch Library].

(4) EFF[Other Library].

Swatches

(5) {E[Open]iHEfii ik {4 "GT_Colors_T.ase".
(%]
o iZfal 5 Photoshop Fil CorelDRAW ANJ], & EAERRIT A SCIFI 1545
B2, f#H llustratorCC i, ilid AR 75BN E bz, BRAUR BN AN AT LA A Bh R,
miitlR A FITNES, kBT [Persistent].

GT_Colors T : Add to Swatches

Sort by Name
Sort by Kind
Show Find Field

Small Thumbnail View
Medium Thumbnail View
Large Thumbnail View
Small List View
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4-4. B O G ST e SR N RN

4-41. BEITEHHIRSHERF

(%]
o GTX-6 {TEINLIRSIFE 1 RGB=255 1" " AL B, ANt i 58  AREHH ] (1 (i 2B T Nl L i B R 58U E 9 RGB=254.
o RTHBIEHINE EEESMARFIMHRIT (5"4-3. FHHMMHTET >>P.84") 5N AT HHD.

(1) RSN HREFPRHTEI TR, SosITEINUAREIRE P AF T B XA

= FTENE IR X

#k/meE EARE

Lt g
EREE: FAEE =
ik Sutc Fa+taosns v
1w (OF:k (@] =1kt b
IR () 1200dpi x 1200dp HG (®)1200dpi x 1200dpi
(0)1200dpi x 900dpi (0)1200dpi x B00dpi

HEDEHRE: ' 5 5 ; 9

ot i B

1 2 3 4 5
P l 3

FIENRSIRL: | 5 1 HEHEE: | 400%

[m={=Eyeald

[CBa&/s a4 T ’7
OFAEAEE (EETNER)

[(JFmr & SRR3R0 TR R AR
FHEE

BT EAHRE.
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(2) AT EIHLIRBNRE Y AT Bl i B TR EA T T AR B
rh[VRANBEE], PTRCEBE A OmE]. [ERRE] [FREFTE.
(%]
o IRIE[HSIEE. FFRENNEAR, iR i E AR,
o TENSIEHE MBIV MBS RN EE R, B RAnTEE, AR,
o RTHRUWEIHIWY, ESRLUEHET.

Brother GTX-6 &GS E=ES >
wEOEHE
(G =R B oreen (0,199,0) =il
’_

B BEnEs: (@) iE (O 1505

1 2

I i

B i 23 45 67 89 10
B EeE ] eeEE: I 2
EFRE

] 10 0 30 40
HF0E: I 5
oE: I o
A E: I 5
FERTE

o g N T R I
B | 0
EAN=E | o
B I o
ES=R I ]
] &=rTEN

JEE ]

(3) WESHA RLHE].
(%]
e M"GTX-6 File Viewer"H ] 7 ARX6 S5 7T 2 AL B E 1{H .
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4-4-2. EFEERRF

N IEY 0N R |1 i 7B £ < 8 N MRS Y 9N I
(%]
o MR HARIKIUEAR Y.

WELH {5 i )
[24 X 24] 24X 24 JEtR 610 ZK X610 ZX
[18%22] 18X 22 [EtR 457 2K X559 =K
[16X18] 16X 18 [t 406 2K X 457 2K
[14 %X 16] 14X 16 [FH 356 %K X 406 ZK
[10X12] 10X 12 JE# 254 2K X305 =K
[7X8] 7 X8 [EHR 178 =K X203 =K
= FTENEEIR e
ke EReE

EfRRST: HHEE

EiREE:

THERE:

T (OF:1: @)=y 1P

SR (O1200dpi x 1200dpi HQ (®)1200dpi % 1200k

() 1200dpi = $00de () 1200dpi = 500dpi
BEBRRE: ' 5 .m =
B l 5
1 2 3 4 5
A I 3
FTEMUSE]: | =1 HAEHES: | a0y

==l

ClBe/s e ST

[CIfIREHIEE (RETIn SR

5t 8 SRETe %8 AR

EiRRT:

IE T TENRREE AR EARA R T,

2424 (609 6609 Brmm)

1822 (457 2558 8mm)

1618 (406 4457 2rmm)

1416 (355 6408, 4rnm) 3¢ 1EHE

10:12 (2540304 8rmm)

78 (1778x2032mm)

ThE HGE
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4-4-3. EREREE
MIEREE: [H NS RiE R ER &,

FTENHLEACEIFTEV T, IHRHs AR R (R AR e S5 o
(%]

AIMCASEE] [Al B [C]s D] [E]s [Fl. [G]s [H]FE#.
EEIRIRE, ARBERREE.

ST ENEE
i FTENES IR P
g/ e BARE
FARRST: HHRE
EESE
R
T
PR W = 1200dpi
(0)1200dpi x 900dpi (0)1200dgi x 600dpi
BEHERE: 1 3 5 2 g
B I ’T
1 2 3 4 5
N l 3
FIENWE): | 1 BEHSE: | 400%
(W]=Eavealdl C Z :
(W=Ere T e
[]FAEHY) R (RET &)
15 eth & SHEETm 1 8 ARrEtE
iR : N B -
FTELHIRYCRIFTENS RN, R B s E S AR TS,
AOSERRIGE T W-Ph=BshEE,
e HiE
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4-4-4. EFEH S

M s iR R A S .

BEEIH

L

Pt At

fE A OHSRIEE EITEROEIE.

(X A =]

R AR, TEEA IR,

(DO 28]

75 RER (R AT ERZ R

[ 8]

R, TEEAEIR.

e FTEDES IR X

fH/mE EFRE
EfRT 14x16 & HHRE
EiREE: FIEE i

FIENES[AL: | 5 1 HEHEE: | 400%

(] &= 5 sTEn
ISl

[JH AR EE(EETI £ )
[]F=@b 8 SEEITED %8 it

=it
EHETEABEIES T
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4-4-5. EFHER

HE: REAACISEEIRG, EEEERM R A G R, AR SRR

(%]

MRAEBERIANE,  SERh KRR ] RE AR,

e FTFESFEIR
s/ mE EARE

BIRACT: 14x16 ¥ PR

BiRSE: HIEE

SR () 1200dpi x 1200dpi HG! (®) 120061 ¢ 1200dpi
(©)1200dpi x 900dpi ()1200dpi » B00dxi
HEBERE: | 3 5 7 g :
B | 5
1 2 3 4 5
S I 3
FIENRS[&]: | x 1 BEMEE: | 400%

ISy call

WIEEXEc=a:ta )

CFIAEHTRE (2E TN EA)
[#E0 8 -S1EITE 1% 8 Aetela

[N
B EEFHIIHEREE, INHEEITHE AEE.
B, RIARE, TR0 TRE A IE MR,
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4-4-6. ERVER

RIS IR BRI R, W E ROCHITER A AR, FTENR TR ANFE

= FIEIES T X

qE/mEE EFRE

BT 1416 X R
R : AHEE b

HERE: YE+OEHE 7

(e (OF:¢:A O BEdhEsE

FIENMS[A]: [ 1 BEMEE: | 400%

mIEEE )

(] =l=re 2= a1 )| :

[ EEMIEE(EET SR

[]Fe0 8 SHETED Sy

DR ERETTHNEEI DR,

1200dkpi > 1200dpi HQ) : TE 8 B[R]0 T Sp A TED . Stol M1 ~Bichifiiz, e

gggdoi % 1200dpi : Sl T ~945 TP e 4E, a0 BBy R TEIR A0 N, ol fEm 0~
200ipi % 900dpi: L AT M| ~G4Ech R4,

200dlpi ¥ 600 : BFER O g1 ¢,

e HGE
R T
1200dpi X 1200dpi %1% 1200dpi < 1200dpi $TE,
. _ 4118 1200dpi X 1200dpi(High Quality Mode)FT Efl.
1200dpi X 1200dpi HQ s o1 . N
P P 1 T SRR £ SR
1200dpi X 900dpi %1% 1200dpi X 900dpi $TE,
1200dpi X 600dpi $%11% 1200dpi X 600dpi $TEN.

(%]
o MRIB[HER: WRE, [FTEIRE: DA L.
o SEPRMBRIEFERIUR TATENEBR NI GR . R E SRR AR .
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4-4-7. HEBEARME

[ SR e: R+ A R A B, BoR[A G SRR E: [REDH .
Fa R AR 1 (TR Mt | (I THEEEMEEN A tahsE) TR,
Ji4h, BEEA G RITEN A EREEAJFT BN A 1 i s ] o

e FTEDRESEIR X

/R BARE

ERR~T: 1416 ¥ T B
EREE: FHEE 6

R D R = >

8 (OF:1- (@)=l

PR () 1200dpi x 1200dpi HG! (®) 1200dpi x 1200dpi

(0)1200dpi % 900dpi (0)1200dpi % 600dpi

=R el

[ g&es 8T 3HTH 0

LIFHERyRE GRRTlTH
®er2 SIEN LT

BEHERE: . s
ERFEOREE N N EENEH, TRE S EL,

109



QAT BNt

[=%n
M~[1312Hi%kFE RGB=254 A GRED . {Elk, At abgin.
A RFTEA R, wI$aE[10]~[13].

R EE AR
[1] {0 S 200%
[2] H s 250%
[3] i 2 300%
[4] {0 S 350%
[3] O 2 400%
[6] i s 450%
[7] {0 SR 500%
[8] {0 SR 550%
[9] 1 (i S 600%
[10] {0 SR 650%
[11] A O SR B 700%
[12] H s E 750%
[13] i 2 800%
[&%]
o HME T HMBIEAEMEAR, FOCRAEREEEAR. EHEEN AR SEREN, RE0IEITEEE. TRt ERSE,
PR EM. 5"4-6-6. ITEHRLRERZEIERR >>P.135"
o HME[RDL: I [AOSVITE. [AEEEAHHTEN. [REANESHAITENORE, FTEDRTE: R[S [RAERk.
o [Eot: REMAMIB [HESRITE. [HEREAHHTE]. RENEEHATTEOFF i, [TENRTE: [AIX1]. KX 1A
FEHEE, SoRATENN RN
o SPRHBIEFERIUATITEN RGN IR . AR i S e R bR .
AT~ [BI% i BB AR i SRR 1) 1 il 2
WEE Tt B
[1]54[2] T AR AT, Pk a)R.
[3] BRI
BCPFEHEI A G, KA, BArER.
[4] EHTAA, R, GESEEHIRE. IHEM BRI,
[3] TERS X DAAME BT DXk BAECK (A i SR 24T El
(%]

FTENEDUR AR, JRFREREA. ="4-6-6. THRIURERIZMEDHERIRE >>P.135"
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H & KATE
HEGUATEHR R, AI{E]~[13]% Pk mpt.
FEMIFAGT BNV E—JZ A0 E it 82 S FAGTT BV 2R 2 A0 E it SRR T 5 8N 0~60 £
UnSR Y E AT BN — R SRR T, BN ERALN TR O 75
[2%]
o - (UDMMEEER |REERIRA 1 R i S T AR

H & EAHIEFTED

FEMIFREITED E— B E S8 2 R G T R i S8 2 RO TR B8N 0~60 £

AR SRBLEL L i SRAT EVEE AR A ], I AN AAHLN TR O 70

[2%]

o - AR |RUEERRAG - OB T DA

o - FTEBNMAERI

o - ATEVMEERITHEAAE. M, STENERE, B A ETER R,
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4-4-8. BERGMHHEMEE

s RO+ A OmE, SoRFAEMIERE CRE T MEAD JBENH .
FTENGRE T HiUw, ABEFERA M R EITEI, WhIRAEMIERE CRE T LD EIEHE.

= FIEIES T X

qE/mEE EFRE

EART: 1418 v RRE
RS FIEE v
B TRtOEhE ¥
[k (OF:¢:A O BEhmEHR
SR (0)1200dpi x 1200dpi HQ (®) 12000l x 1200dpi
(0)1200dpi x 900dp ()1200dpi x 800w

DEhERE: 1 3 5 4 g

SR | 5

1 2 3 4 5
Ak | 3

[]Ba@sreTe

]_
Si=recgs tals !
T =

TR & fAEfE
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4-49. REROGHEMEGHEITEH

[RfiEe=vim= S b Shviik =< P i s S REERTiiE-) NI (G A SR HE Y Y (St o~ ) SRl IR 5 = S N PR N A S D =Ry = K e AR (S el
Ho

FTENRCRIOA/ RSO RN, 1Erh R A R AR ST BN SR .

(%]

o HMEEF[REMESHAITH], HKHSEEBAL.

o IEHROIEGEITENN, TEIREASK. RRAREESIRTEIN E: .

i FTENEETR X
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(%]
o TENNLIREHFER R BB I
- (FFH A EIm SR T ENEE RS, ="4-4-1. BT EIHLIRSITET >>P.102"
- PSR BB i SR AT EN S, ='4-5-1. BEEITEINLIRSHAT >>P.120"
o HIMEiAHIOK], FTEMNLBIIETFUAITEN. & FATEMNURAT EIEATF A TER
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Adobe Photoshop

(1)  MSEHA=higE[File]>[Print]l. PC — & f&H 4T EIHL N "Brother GTX-6"51"Brother GTX-6 FileOutput'itf, HFhi i E
R

(2) BATLATBE.
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Photashop Print Settings X

Printer Setup
Brothe

1

Layout: [ B

Color Management

Description

Position and Size
Anrbinng

Reset

(3) M[Printer]#i&+"Brother GTX-6"-
(%]
o ¥[Printer] & & A"Brother GTX-6"H, TENRE KIEZFTEIHL
¥[Printer] i3 & A"Brother GTX-6 FileOutput"fit, FTEI%ELL ARX6 SCHH#-1F
(4) 7E[Print Settings] 1% & T ENFLIRENAEFE, AT [Print] 54T ENEHE .
(%]
o ITENHLIRENFE AR E 2
- [ ATl BAITENARER, =4-4-1. BEFTEHUERSITET >>P.102"
- FUT IR el e B T ENERRT, =4-5-1. WEITEWIIRESFERF >>P.120"
o MM SHAPrnt, FTEMHIHBICIEIFLGFTED . $5 FHTEDHUKIFT ENFAR LG ER
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Adobe lllustrator

(1) Mk rhi%$EFile] >[Prinf]>[Color Management].
2) HATUTRE.
o  [Document Profile]: [sRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]
e  [Printer Profile]: [sRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX-6 FleQutput

General

Marks and Bleed
Output

Graphics

Color Management

Color Handling: Let Illustrator determine colors
Printer Profile: sRGB IEC61966-2.1

ing Intent: | Relative Colorimetric

(3) M[Printer]#i&+:"Brother GTX-6"-
[(5%]
o ¥4[Printer] 3 & N"Brother GTX-6"Itf, TEN%E &IEZEITEIHL.
K [Printer] % & N'"Brother GTX-6 FileOutput"i}, FTENEHELL ARX6 SCAHRAE .
(4) fr[Advanced] % EFTEPHLIRANFEFY, i [Print] &% HT EN % .
(%]
o ITEMHLIRBIIRF I E Tk
- (FHH Ayl SR FT ENER R, ="4-4-1. BT EINLIRsITET >>P.102"

- AR ORISR HITEN SRR, ="4-5-1. W EFTEIHLRshRERF >>P.120"
o AP, FTEMHLICIEIFIRITEN. $2 T HTENHLIHT ENFEATITARTTEN
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5-6-3. M USB B \FTENEIE (ARX6 L)

(1) K USB fififiastdi NAFAE AR AT THI 1) USB fEfifiastdi .
[FE%]
o B AR USB ffikes. B, FRESHUR.
[Z%]
o [EHINZEEN 2GB~32GB, il FAT32 #&\ 1Ll USB fFifide. okl Sl aiThre s 2 TiResk T 32GB 1) USB
Trites.
o i USB TEAi 2L A% AN ARX6 #5350, ARXP #% M1 ARX4 #& =%

USB {1

(2) MR T B, mﬂ@o
[5%]
o RSN ESRHE R

KB

VAR ISR = L
ITERLIEE
FTEII
KT 2
PR BNl

(3) HEFTEISCHE 4, ﬁ%ﬁ??@c
[5%]

o ittt [ R Sow (] el
o USB/#RfEHNHTCAREREE 3 2. AR 4 ZU T IR,

- T I 3L < THIEFEAF

O Sample Folderl < Sample Folder1

; [3 Sample Folder2 o | O Sample Folder2
— » Sample Datal.arx6 — Sample Datal.arx6
3 Sample Data2.arx6 2 Sample Data2.arx6
Sample Data3.arx6 Sample Data3.arx6
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(@) AT 57 #?ﬁT@o

[H#]
o ITEMZHINMRIIE, E20MAE USB f7##S. BT SRR EEEIR.
(%]

o RIEEGEMAN, SHATREFE LR
o TGIAEEHN USB f#as N HISCI . =81, KA MRS >>P.258"
o [A—AMHRANEANZNTEESER, nliE A W AT T s

Sample Data

# 14 x 16 inch
¢ 5. 45cc

SHEIZENOK
FTEIREHIIRN 4 L
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5-71. FTEI13K

™

BAATEN R

BASOWIRATENZELINKR, BACERE, 7FEnSme, $TEHIZ AT -
FEEIPON 2 7, TRFIEIE 2R (N IS ARONT T B (K LR RS A
(%]

o BT HZATHRREBOT AR,

o AT HZHIAREBRT EHRIT, A R

(2) B ST SR B TEI R, FIRHS% 2 AN FT BN G T T Bl
[=%]
o FNITENAA AN R e — e i 18] RS v .
FAEE TR 2 RS, JRFATFS R, DT ENECH .
(3) HTENSERUE, IR B REET AT E, KPS,
(%]
o JENRKRMIMEAIFESIN, BMEIE NI EN4R4, WIHIFIRHTEN.
o IR @ JEFTENEUH .
o  AERERNEEALASCTHIET, fiif]AamaRiTEN, SIS REET.
(RIS ATES, FTENRS AT ENFFaRaT I ZEdr i TR n BE AR K . TEARIE FE BRI T B . 1ESIR="7-11. WE KRR
FTENENE >>P.243",
o EIRGBHIFIEN, FTENGWREH4E A ATREAS K. BoRIE ARG B EEE, PO SR NG R,
SFTEMFIETERE . =101, 38 >>P287"
5-7-2. FTHIZHK
PRAFFTENEHE, AI$TENZ 5K,
[=5]

™

)

@)

DIWTERE, MR OR A R -

BB TR s ZAT BN, RN 2 AT EHEHDTAGTED.
(%]
o HERITEMZAHI AL T )G — e [R5 S A
ZAEEZENTEIE 2 SO, RFATFER,  TENRGE.

ITENTERUS, KeIAE B Eia Al Az &, A" .
(%]
o IRBURIATHHRTESSINT, BRI THTEMZHE], HICiEIFIRITED.

o HIT @ JEFTERHI -

o R EIRITEIAITKEL

o EENREALASCTHIET, HHACMBITER, WRSTHERIRET.
RIRIZATI, TN (AT AR T RI4ES N ()W) REAR K. TR 2R IRIRIS TR E.. 1S e"7-11. WERIRN )
{TENZHE >>P243",

o EmKIRAIIREIN, FTENGHURRI4E I A AR, SRR E S E RS, PR SCEIR AR R ], A
BFEMRIENE . ="10-1. 3% >>P.287"

SEHEARAFTENA B (T D, FEHTEE 2 e R s TR AL
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5-7-3. MBWGCRITED

] LA L 25 B T N
(%]

4|
O H

e ORAF T BNl iR 2 0 100 4>, $Eit 800MB, Mt - HT ENEeE FAnhb: o

o UMW, RHMIRRORAT IR
(1) NSRRGSR IR T B e .

(%]
FEI T BRSCHUR AN B AT BN -

(2)  HAB R TR R B TEN AR, [RIHKA% 2 NMTEZHITAGTTED

(%]
AT EMEHIN A% T 5 — RE I A SRS P .
AL E T BIER 2 00, GRFATFIL R, T ENEGH -

(3) ITENTERA, KIS BRGELTATAIA B, A EE .

(%]
FEBCR TS SIS, R RATEEAL, I TATE

T @ JEFTEIGH
FEENIREAE 18CHRIMEE T, A CMSEITEN, AR tfe IRz,

RIRIZATI, TN (AT AT HI4ES N ()W) REAR K. TR 2R IRIRIS TR E . 1S e"7-11. WERIRN )

{TENZHE >>P243",

Tl (IR AP , FTENE R 4RI AT B omil AR B 15 15 2

GFTEMRIETEHE. =101, & >>P287"
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5-8. FTEITZ)
IR AR TENHLARAL TR UIRES, T ied F12e 49 R AT BN TRAIT BN, 64T ENHLAS vl 4T BRI, BT FFAA4T .

5-8-1. T THLIFTENFIE [A]

PRYHTENEE A TENS AR ACBIA), TTSE 4 T AT BN DABEAT T —4TE.

FTERZEAEICN T, IR EBCEDRT ) T M5e s, FTEMHLIEAERET b ANTENR S A FREER, W LA .
(%]

o WAMEAR EHURFTENSERN T, JFAE AR R B F—DNEHTEIR T M5 FHE TR

o NRHBRAESITHTENUN AR AEAEFTERRIN, #TCIETSEA T Ty

A FRAFT ENFRI AR B
FAAT EP R FTEPHLEIT USB 3.0 ZR45/LAN L4 (5 Ha05d T Enictiz )
FTENE A Ja AL A TTENSERAF P, #HTEE B0, BINGEE. THS BRI

5-8-2. TEIJT4RHTIHE]
FRAFTEE, FTENJHRI E A R R s

FREIHT ENIS 8] FTENTT R 8]
AT BN KR ] T ENEi A A e e Al
FTENE [)a AL R B B0 BIBGES $THE A GRS E A B A e i,

(%]
o TRZETENEBRTENIFAAMIE, ITEHZHIRENER.

5-8-3. TLIEFFGEFTEHIRIIEMN

RALNTGOUN,  BMEZ IS AR TEN
o JHUASTENRS, AAERTRIT. (Bt BLE—JHTHE, bR D
o JFURITENRS, FTENHLEBATFHTEN %

5-8-4. EUHITEITZ
TRLHTENEEHTENFAEIANE, AlEid e FEGY H R BT EN T .
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5-9. MWEAREHFT

(1) ARFHTEMRIE S, R LT
[EZ]
o ITEITEIMh SR, 1E2fild
o T hiufibihsRnt, T EEERKER.
o T IEEE A LI BRI, IR RS TR
(%]
o HHTUERARER, [MUCALEE T A 20 it T EN I AT T

T fif

X1044
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SE S SR8 FH A ELATEAR o
o HAELED
L PEE RIS TA] R P g 5 {8
o B
TTENSRA N, s fEleE.

GE=9
o IH{ERIFEENIIE M RAERENAIAAE . SR, T s = .
(%]
o EMATEN, AIREH TURAREEE .,
o IHTICIEE TR AR BRI R ST o

ISR K55 mT REFE 2IFTEN T L.
o WRAEAGHRROIRELIAEGHBCE LEERITER, WATRES R0,

AN SRR I BE AU i S84 T ENROST B AN (3 o S8 TENAOFT BN, MU [RIFE & SRt

BRGNS, R P AT B R E R P Bl A T B 5 15t
o IRIATUCEGHEAERERAMSEN T il ESTR BRI R FE TG,
o 88 5 R AR BAEE
IRE AR AN TR SORRAE,  SIE A2 DR AP BRI AN R T o 1S SR BN UE ERCR 5 AT Rt
(%]
o MRUEBAIIIAGLENRIRAERNSE, RAEFAFAR, BIER A RRER ] . 115 5553 Se A IR AN 52 52 RE SR K R iR

Bk
o MRMETEIN, WATREADpesE, BRI AR IR,

JEHFERIATAL B (M A S e A
o FABRENRS, VERAIATSRE AR PR ST .
o HMEHT TAMERTR IR IED TR, IBTENIER I TR DU RIS AR 8] o

Hlas T I 1]
FAFEEN 180°C (356°F) 35 i
HEAF FIiE 160°C (320°F)" 34y 30 #+~5 43

“1: R TR t, PRI RAE R P
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BT REEEN e R

(1) CRARfIR, T Al A SRBS RO E BT B _E IR e R a8
(%]
o HMEREMFIAINRE =5-10 TSR >>PA71"
o IBESIRERA IAEREME IR
o WSRERCHSBN A REAROARIBIAR, WA e BB RCR AR, an SR SRR F A SEBOCERCR I . TR
XA -

FAEZED

FIBIAR
Rk \/
T i
X0115
B AR A AR
(1) AL 2UMEFE T T ML T a8 e 5
[=%£]
o HBEMEAMHNME =510, EHHE >>PA71"
o XHTAERAECHA, TERIARE IR R SR R AR
o IHSHEERA LT AUES AR R
T e A
[
I I
out in
X0116
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A SER

ZS}@m%ﬁ&%&ﬂ%@ﬁi%oﬂ%%ﬁ,%%%5%%25%?%%0

AEE

LA\ RUERL B, TR T, AT, WA FECR.

69 VKM, TE. FUCE. RREA. A RSO . ikek,
WAk, REFEVHSR. V. BUCERR. BEESAIT, SR BB T, DR s e B F X
Seyith, BATREERAR 4. HENIRES IS IEEE, ST R k.
FEHCE L) LB BN BT o
() VRPRHEI, RGBT BB T, UG IR ol s g .
EMATRE SR 4 .
Wb, BRI, BN SRS . MR,
B )L B B .
q) FEHENE, R R, BHAAAT B R, ST RS BT S R i, AAF
N

" THHIRE U R D IR MR, e I R IRER P IR, AT Be B 1y sl .

(MEZEHD

TEZ A TFHESN AR A5 AT RE-FECAL L™ B
TERRAH LR R 052 8] IS 20 BNt 7300 §E Bl S2 i

e
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6-1. EHPATER
6-1-1. I REAME

ﬁﬁ?ﬁ*ﬁ@@ﬁ‘]?ﬂﬂ%ﬁiﬁﬂﬁlﬂi LRl
| GE=9

o RN, WEMBRALMTE. I HEL

o ERAEEKIMSBMEENT IC #.

o FhruithERRS, HHA IC HRATIEITEL

DIREERPR
Fhreihss B

(1) MSESAEH S, ST @ -
(2) MEBE]L DEEL [FE) Earsn BRI, T @ -

(3) FNSHFI A IC 4, e T @Y -
(2%)
o WIRHAEASH R RBIEA RS IC #, H Rz,
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(4) FToTMEImR G, 22 BB A heZE .
[E%]
o IHAMBRURSHIMTIRE, DML L AT
o IEZMEMIBEMAIEZE AN S R RPN AR S AR, AT EIL B

JiezE

biiEsssiin

X1036
(5) HTUTuh=RER G, KrmsRehe s 4 FTMIZIELLL b,
(%]
o BT 6 FIINZIEL.
N
J
X1070

(6) e FHfnbu @ . SRR @ -
€
o FNTEIISRE AR P SR ) o o
(1) BEEERGER, R 1C T @ -
€3
o IC HEREMSTE S TR AT IR
o IFIRNGESHUE LI S RS-
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6-1-2. (M REEME

E?'M’Eﬁff)i@ﬁﬁ’ﬂ?ﬂﬂé%%ﬁﬁﬁlﬁﬂ‘ R RN

74h, BT AR ITIE, FEAN RSB ATE E I BB T K. TP I E],  RiE it

k.

(=]

o [HEMIBEREATEKIHERN, ATRESBATENMMANEARZ, TELAR . AR TE SR A A R, RIEEA A
TREHIN, WMATRER ESAT4EET A

o IHBERAMBIMAIATHE.

o WURKFEBURFERG NS TR, WATRE SR A S BUTEIHL L B

[FE]
o R, ERIBRALGTE. P HHE.
o UEREAEERMABIMBEMLT IC H.
o fhrEuhRI, FA IC HEHITCIEITEN.

BB A EahR
[(H%]
o EBLIABHEL
BT BEELA AR, DA A S (2 R0
[(£%]
o BEPEOEMME, AT, WA SRR IC .

(1) RS EEL .
(%]
o ONBAEBERErhuh SRR, 1 e AR [

(2) IESIREHFEYL R BB TR
(%]
o TEPHIN RIS TRVHRHavth 58 A BN R AIBE L P RE A R AR
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(3) ETEE S, SR I

JEH RSB AU EY), B ERPIR (1) (2) HEHIHEA.
(%]
o HYISERIRRBIIFAEE B, UMER S B RITED.

AR [ U | BT

- A

<

5 B ™
\R e 1=& j\ SRR

X1037

HIURY)
TR MabzS
X1045
[5%]

o (EHFFACMERSE, ANTCEX BRI TAVTEY, FIEE BEERIE R TN
XMV T iR R R S S, R T RS AN, MISUTEY) -
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EEENE SN e

QIR
whremhsR At

(1) PR ), #&*T@o
2) EEAL), J‘H‘QT®G

(3) AL IC H, a‘ﬁﬂ®o
[5%]
o HEEAN GBI REEAFZEN IC ¥, KERER.

IC A
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(4) FToTMEImR G, 22 BB A heZE .
[E%]
o IHAMBRURSHIMTIRE, DML L AT
o IEZMEMIBEMAIEZE AN S R RPN AR S AR, AT EIL B

JiezE

TS

X1036
(5) ATTTARRER G, RFHmARA R 6 T UTHIZIEALL L.
(%]
o L 6 LTZIEL.
~
6
5
4
8
2
1
J
X1071

6) TR @ . smmmamEaE T @ -
[%%)
. MRS

(1) BEEERGER, R 1C T @ -
€3
o A IC HRREISTEM SRR TR AT IR E
o IFIRNGESHUE LI S RS-
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6-1-3. FMFRIBELLR

i‘ﬁéf’ﬁﬁ*)ﬁ@ﬁﬁ‘]?ﬂﬂﬁiﬁﬁﬁlﬁi LRI iE=8
[EE]

o R, ERIBRALGTE. P HHE.

(%]

o THINBILRHENTERRE, WEDNBIEHTHE.

QiR
IR

(1) Mg s, T @ -

(@) s, T @ -

(3) TR, SRR,
[£%]

o TEMERUSSERATIRE, BiILFAE AR IEZE BRI ARAR T
o IE/ERIBEM AEIE ISR RTRE AR S AR, S BT R Bl

JiezE

ERPRILEiiH

X1036

180



N T BRORAT BN R/ S 75 i
(4) FTTHEUCER S, RHRTERANEE 6 FTIZIEELLL B,
[H#]
o EZE 6 LITHIZIEL.

2N wsrolo]

X1072

(5) s Tademb @ . i T @ -
[£%]
o HIIBVERUE LAORPIREHER 5 .
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6-14. BIEMBERE

TN N EVSY R LA ARTHE 25

0Lt

SR GHEAE 1L ]

(1) A > (e R R e, JrT @ -

(2) JEL AV ENIBEEIAE, ST @ -

B IE R RER BRI

4
NI R
4% T OK

(%]

o WHIMEILIR LSRR

o BNAEZIESZIFEZ AN, ZRCLMERITEIE.

[EE]

o INHNRIVEEICIEIERIRAIARE, PR SPEGTEINLH B,
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MRVETOARE ] [ R (5 B S, 1 i S 4 A
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B AR
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B RSO R

[Z%]

o SRTHEII, ESREYHT BN
="6-1-6. FEHLFHIR >>P.184"
="6-1-7. HHFEIER . SRR >>P.186"
="6-1-8. FEH P RIS AL >>P.189"
=6-1-9. HEHFEEFRYAARL >>P.192"
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o EAEHGEIR. rREETIOREL SRR SRR TR, — BTSSR R R TE R E R
(1) HERBEIHEAEFEDUEIN.
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(5) MEMHRAERTHRIRAI RN, FEAA MR
[E%]
o I[N R 4 bR
o IB/FFHEIRIN LTI
o LRI, BAEA R TRERIRA.
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o BRI IR AT -
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Open Source Licensing Remarks
This product uses one or more of the following open software, depending on the features which each product has.
gSOAP / SNMP Software from West Hawk / OpenSSL / Lua This software is used in all our products.

MIT Kerberos
This software is used in the product which supports the Kerberos Authentication.

Cyrus SASL / OpenLDAP
This software is used in the product which supports LDAP.

expat/ LibTIFF/ libjpeg/ libpng
This software is used in the product which supports RSS Reader, XPS emulation for Direct Print feature, or PDF
creation module.

libstrophe/json-c
This software is used in the product which supports Google Cloud Print.

Open SSH
This software is used in the product which supports Secure Scan FTP.

Open NFC / linux_libnfc-nci
This software is used in the product which supports NFC.

USB Host Driver (in FreeBSD)
This software is used in the product which supports Direct Print / Scan to USB.

mDNSResponder
This software is used in the product which supports mDNS.

wpa_supplicant and hostapd
This software is used in the product which supports Wireless LAN or IEEE802.1X.

T-Kernel
This software is used in the product as Operating System.
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The following is the full text.

Part of the software embedded in this product is gSOAP software.
Portions created by gSOAP are Copyright (C) 2001 2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, provided
that the above copyright notices appear in all copies and that both the copyright notice and this permission notice appear
in supporting documentation. This software is provided "as is" without express or implied warranty.
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This product includes SNMP software from WestHawk Ltd.
Copyright (C) 2000, 2001, 2002 by Westhawk Ltd
Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, provided

that the above copyright notices appear in all copies and that both the copyright notice and this permission notice appear
in supporting documentation. This software is provided "as is" without express or implied warranty.
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MIT Kerberos statements

MIT Kerberos license copyright Version 1.6.3

Copyright (C) 1985-2007 by the Massachusetts Institute of Technology. All rights reserved.

Export of this software from the United States of America may require a specific license from the United States
Government. It is the responsibility of any person or organization contemplating export to obtain such a license before
exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this software and its documentation for
any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that
both that copyright notice and this permission notice appear in supporting documentation, and that the name of M.I.T.
not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
Furthermore if you modify this software you must label your software as modified software and not distribute it in such a
fashion that it might be confused with the original MIT software. M.I.T. makes no representations about the suitability of
this software for any purpose.

It is provided "as is" without express or implied warranty.

THIS SOFTWARE IS PROVIDED "AS I1S" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

Copyright (C) 1998 by the FundsXpress, INC. All rights reserved.

Export of this software from the United States of America may require a specific license from the United States
Government. It is the responsibility of any person or organization contemplating export to obtain such a license before
exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this

software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright notice and this permission notice appear in supporting
documentation, and that the name of FundsXpress. not be used in advertising or publicity pertaining to distribution of the
software without specific, written prior permission. FundsXpress makes no representations about the suitability of this
software for any purpose. It is provided "as is" without express or implied warranty.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

Copyright 1993, 1995 by OpenVision Technologies, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that the above copyright notice appears in all copies and that both that copyright notice
and this permission notice appear in supporting documentation, and that the name of OpenVision not be used in
advertising or publicity pertaining to distribution of the software without specific, written prior permission. OpenVision
makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or
implied warranty.
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OPENVISION DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL OPENVISION BE

LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

Copyright 2000 by Zero-Knowledge Systems, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that the above copyright notice

appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation,
and that the name of Zero-Knowledge Systems, Inc. not be used in advertising or publicity pertaining to distribution of
the software without specific, written prior permission. Zero-Knowledge Systems, Inc. makes no representations about
the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

ZERO-KNOWLEDGE SYSTEMS, INC. DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
ZERO-KNOWLEDGE SYSTEMS, INC. BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTUOUS ACTION, ARISING OUT OF OR
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2006 Red Hat, Inc.
Portions copyright (c) 2006 Massachusetts Institute of Technology All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Red Hat, Inc., nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES,

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FORA
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Copyright 1995,1996,2003,2004 by Sun Microsystems, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that the above copyright notice appears in all copies and that both that copyright notice
and this permission notice appear in supporting documentation, and that the name of Sun Microsystems not be used in
advertising or publicity pertaining to distribution of the software without specific, written prior permission. Sun
Microsystems makes no representations about the suitability of this software for any purpose. It is provided "as is"
without express or implied warranty.

SUN MICROSYSTEMS DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL SUN MICROSYSTEMS BE
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

COPYRIGHT (C) 2006-2007

THE REGENTS OF THE UNIVERSITY OF MICHIGAN ALL RIGHTS RESERVED.

Permission is granted to use, copy, create derivative works and redistribute this software and such derivative works for
any purpose, so long as the name of The University of Michigan is not used in any advertising or publicity pertaining to
the use of distribution of this software without specific, written prior authorization. If the above copyright notice or any
other identification of the University of Michigan is included in any copy of any portion of this software, then the
disclaimer below must also be included.

THIS SOFTWARE IS PROVIDED AS IS, WITHOUT REPRESENTATION FROM THE UNIVERSITY OF MICHIGAN
AS TO ITS FITNESS FOR ANY PURPOSE, AND WITHOUT WARRANTY BY THE UNIVERSITY OF MICHIGAN OF
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE REGENTS OF THE UNIVERSITY OF
MICHIGAN SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING SPECIAL, INDIRECT, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, WITH RESPECT TO ANY CLAIM ARISING OUT OF OR IN CONNECTION WITH
THE USE OF THE SOFTWARE, EVEN IF IT HAS BEEN OR IS HEREAFTER ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Copyright (c) 2002 Naval Research Laboratory (NRL/CCS)
Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided that both
the copyright notice and this permission notice appear in all copies of the software, derivative works or modified versions,

and any portions thereof.

NRLALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" CONDITION AND DISCLAIMS ANY LIABILITY OF
ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE.

Copyright (C) 1986 Gary S. Brown. You may use this program, or code or tables extracted from it, as desired without
restriction.

Copyright (c) 1994 CyberSAFE Corporation

Copyright (c) 1993 Open Computing Security Group
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Cyrus SASL statements

The Cyrus SASL License

Copyright (c) 1998-2003 Carnegie Mellon University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived from this software
without prior written permission. For permission or any other legal details, please contact.

Office of Technology Transfer
Carnegie Mellon University
5000 Forbes Avenue
Pittsburgh, PA 15213-3890

(412) 268-4387, fax: (412) 268-7395
tech-transfer@andrew.cmu.edu

4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software
developed by Computing Services at Carnegie Mellon University (http://www.cmu.edu/computing/)."

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO HIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL CARNEGIE MELLON UNIVERSITY BE LIABLE FOR
ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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OpenSSL statements

OpenSSL License

Copyright (c) 1998-2019 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived
from this software without prior written permission. For written permission, please contact opensslcore@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without
prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software
developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (c) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so
as to conform with Netscapes SSL.
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This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The
following conditions apply to all code found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just the
SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the
holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is
used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the
form of a textual message at program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can
be left out if the rouines from the library being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must
include an acknowledgement: "This product includes software written by Tim Hudson ({jh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e.
this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]
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OpenLDAP Statements

This product includes software developed by the OpenLDAP Project.

Unless otherwise expressly stated herein, The OpenLDAP Public License Version 2.8 shall be applied to individual files.

Copyright 1998-2007 The OpenLDAP Foundation All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted only as authorized by the
OpenLDAP Public License.

A copy of this license is available in the file LICENSE in the top-level directory of the distribution or, alternatively, at
<http://mww.OpenLDAP.org/license.html>.

Portions Copyright 1999 Lars Uffmann.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted only as authorized by the
OpenLDAP Public License.

Portions Copyright (c) 1990, 1993-1996 Regents of the University of Michigan. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that this notice is preserved and that due credit
is given to the University of Michigan at Ann Arbor. The name of the University may not be used to endorse or promote
products derived from this software without specific prior written permission. This software is provided “as is” without
express or implied warranty.

Portions Copyright (c) 1999, 2000 Novell, Inc. All Rights Reserved.

THIS WORK IS SUBJECT TO U.S. AND INTERNATIONAL COPYRIGHT LAWS AND

TREATIES. USE, MODIFICATION, AND REDISTRIBUTION OF THIS WORK IS SUBJECT TO VERSION 2.0.1 OF
THE OPENLDAP PUBLIC LICENSE, A COPY OF WHICH IS AVAILABLE AT
HTTP://WWW.OPENLDAP.ORG/LICENSE.HTML OR IN THE FILE "LICENSE" IN THE TOP-LEVEL DIRECTORY OF
THE DISTRIBUTION. ANY USE OR EXPLOITATION OF THIS WORK OTHER THAN AS AUTHORIZED IN VERSION
2.0.1 OF THE OPENLDAP PUBLIC LICENSE, OR OTHER PRIOR WRITTEN CONSENT FROM NOVELL, COULD
SUBJECT THE PERPETRATOR TO CRIMINAL AND CIVIL LIABILITY.

Portions Copyright (c) The Internet Society (1997).

See RFC 2251 for full legal notices.

The OpenLDAP Public License Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are
permitted provided that the following conditions are met:
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1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of conditions, and
the following disclaimer in the documentation and/or other materials provided with the distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished by a version
number. You may use this Software under terms of this license revision or under the terms of any subsequent revision of
the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS “AS IS” AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
OPENLDAP FOUNDATION, ITS

CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT,
INDIRECT,INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote the sale, use or
other dealing in this Software without specific, written prior permission. Title to copyright in this Software shall at all times
remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation. Copyright 1999-2003 The OpenLDAP Foundation,
Redwood City,California, USA. All Rights Reserved.

Permission to copy and distribute verbatim copies of this document is granted.

A number of files contained in OpenLDAP Software contain a statement:

USE, MODIFICATION, AND REDISTRIBUTION OF THIS WORK IS SUBJECT TO VERSION 2.0.1 OF THE
OPENLDAP PUBLIC LICENSE, ACOPY OF WHICH IS AVAILABLE AT
HTTP://WWW.OPENLDAP.ORG/LICENSE.HTML OR IN THE FILE "LICENSE" IN THE TOP-LEVEL DIRECTORY OF
THE DISTRIBUTION.

The following is a verbatim copy of version 2.0.1 of the OpenLDAP Public License referenced in the above statement.

The OpenLDAP Public License

Version 2.0.1, 21 December 1999

Copyright 1999, The OpenLDAP Foundation, Redwood City, California, USA. All Rights

Reserved.

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a
copy of this document.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "OpenLDAP" must not be used to endorse or promote products derived from this Software without prior
written permission of the OpenLDAP Foundation. For written permission, please contact foundation@openidap.org.

4. Products derived from this Software may not be called "OpenLDAP" nor may "OpenLDAP" appear in their names
without prior written permission of the OpenLDAP Foundation. OpenLDAP is a trademark of the OpenLDAP Foundation.

5. Due credit should be given to the OpenLDAP Project (http://www.openldap.org/).

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS “AS IS” AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
OPENLDAP FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

RFC 2251 Full Copyright Statement
Copyright (c) The Internet Society (1997). All Rights Reserved.

This document and translations of it may be copied and furnished to others, and derivative works that comment on or
otherwise explain it or assist in its implementation may be prepared, copied, published and distributed, in whole or in part,
without restriction of any kind, provided that the above copyright notice and this paragraph are included on all such
copies and derivative works. However, this document itself may not be modified in any way, such as by removing the
copyright notice or references to the Internet Society or other Internet organizations, except as needed for the purpose of
developing Internet standards in which case the procedures for copyrights defined in the Internet Standards process
must be followed, or as required to translate it into languages other than English.

The limited permissions granted above are perpetual and will not be revoked by the Internet Society or its successors or
assigns.

This document and the information contained herein is provided on an "AS IS" basis and THE INTERNET SOCIETY
AND THE INTERNET ENGINEERING TASK FORCE DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY WARRANTY THAT THE USE OF THE

INFORMATION HEREIN WILL NOT INFRINGE ANY RIGHTS OR ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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expat

Copyright (C) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (C) 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

303



Libtiff Copyright and License

Use and Copyright

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon
Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
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libjpeg

this software is based in part on the work of the Independent JPEG Group
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libpng

This copy of the libpng notices is provided for your convenience. In case of
any discrepancy between this copy and the notices in the file png.h that is
included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following
this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.2, April 25, 2013, are
Copyright (c) 2004, 2006-2012 Glenn Randers-Pehrson, and are
distributed according to the same disclaimer and license as libpng-1.2.5
with the following individual added to the list of Contributing Authors

Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are
Copyright (c) 2000-2002 Glenn Randers-Pehrson, and are

distributed according to the same disclaimer and license as libpng-1.0.6
with the following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux
Eric S. Raymond
Gilles Vollant

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the
library or against infringement. There is no warranty that our
efforts or the library will fulfill any of your particular purposes
orneeds. This library is provided with all faults, and the entire

risk of satisfactory quality, performance, accuracy, and effort is with
the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are
Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and are

distributed according to the same disclaimer and license as libpng-0.96,
with the following individuals added to the list of Contributing Authors:

Tom Lane
Glenn Randers-Pehrson
Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are
Copyright (c) 1996, 1997 Andreas Dilger
Distributed according to the same disclaimer and license as libpng-0.88,
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with the following individuals added to the list of Contributing Authors:

John Bowler
Kevin Bracey
Sam Bushell
Magnus Holmgren
Greg Roelofs

Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are
Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors"
is defined as the following set of individuals:

Andreas Dilger
Dave Martindale
Guy Eric Schalnat
Paul Schmidt

Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,

including, without limitation, the warranties of merchantability and of

fitness for any purpose. The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special, exemplary,

or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this
source code, or portions hereof, for any purpose, without fee, subject
to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not
be misrepresented as being the original source.

3. This Copyright notice may not be removed or altered from any
source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without
fee, and encourage the use of this source code as a component to
supporting the PNG file format in commercial products. If you use this
source code in a product, acknowledgment is not required but would be
appreciated.

A'"png_get_copyright" function is available, for convenient use in "about"
boxes and the like:
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printf("%s",png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in the
files "pngbar.png" and "pngbar.jpg (88x31) and "pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a
certification mark of the Open Source Initiative.

Glenn Randers-Pehrson

glennrp at users.sourceforge.net
April 25, 2013
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libstrophe

Copyright (c) 2005-2009 Collecta, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

309



json-c
Copyright (c) 2004, 2005 Metaparadigm Pte Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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Open SSH

This file is part of the OpenSSH software.

The licences which components of this software fall under are as follows. First, we will summarize and say
that all components are under a BSD licence, or a licence more free than that.

OpenSSH contains no GPL code.

* Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland

* All rights reserved

* As far as | am concerned, the code | have written for this software

* can be used freely for any purpose. Any derived versions of this

* software must be clearly marked as such, and if the derived work is
* incompatible with the protocol description in the RFC file, it must be
* called by a name other than "ssh" or "Secure Shell".

[Tatu continues]

* However, | am not implying to give any licenses to any patents or

* copyrights held by third parties, and the software includes parts that

* are not under my direct control. As far as | know, all included

* source code is used in accordance with the relevant license agreements
* and can be used freely for any purpose (the GNU license being the most
* restrictive); see below for details.

[However, none of that term is relevant at this point in time. All of these restrictively licenced software
components which he talks about have been removed from OpenSSH, i.e.,

- RSAis no longer included, found in the OpenSSL library

- IDEAs no longer included, its use is deprecated

- DES is now external, in the OpenSSL library

- GMP is no longer used, and instead we call BN code from OpenSSL
- Zlib is now external, in a library

- The make-ssh-known-hosts script is no longer included

- TSS has been removed

- MD5 is now external, in the OpenSSL library

- RC4 support has been replaced with ARC4 support from OpenSSL
- Blowfish is now external, in the OpenSSL library

[The licence continues]

Note that any information and cryptographic algorithms used in this software are publicly available on the
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can be
found e.g. at "http://www.cs.hut.fi/crypto™.

The legal status of this program is some combination of all these permissions and restrictions. Use only at
your own responsibility. You will be responsible for any legal consequences yourself; | am not making any
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claims whether possessing or using this is legal or not in your country, and | am not taking any responsibility
on your behalf.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY

FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR APARTICULAR PURPOSE. THE ENTIRE RISKAS

TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILLANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED

TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

4)
The Rijndael implementation by Vincent Rijmen, Antoon Bosselaers and Paulo Barreto is in the public domain
and distributed
with the following license:

* @version 3.0 (December 2000)

*

* Optimised ANSI C code for the Rijndael cipher (now AES)

* @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>

* @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
* @author Paulo Barreto <paulo.barreto@terra.com.br>

*

* This code is hereby placed in the public domain.

* THIS SOFTWARE IS PROVIDED BY THE AUTHORS "AS IS" AND ANY EXPRESS

* OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

* WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE

* LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;

OR
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* BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY

OF LIABILITY,

* WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
* OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,

* EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5)
One component of the ssh source code is under a 3-clause BSD license, held by the University of California,
since we pulled these parts from original Berkeley code.
* Copyright (c) 1983, 1990, 1992, 1993, 1995
* The Regents of the University of California. All rights reserved.
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the above copyright
* notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in the
* documentation and/or other materials provided with the distribution.
* 3. Neither the name of the University nor the names of its contributors
* may be used to endorse or promote products derived from this software
* without specific prior written permission.
* THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS
“AS IS"AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
* SUCH DAMAGE.
6)

Remaining components of the software are provided under a standard 2-term BSD licence with the following
names as copyright holders:

Markus FriedI
Theo de Raadt
Niels Provos
Dug Song
Aaron Campbell
Damien Miller
Kevin Steves
Daniel Kouril
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Wesley Giriffin
Per Allansson
Nils Nordman
Simon Wilkinson

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

*

*

* THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR

* IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
* OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
* IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT,

* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
* DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY

* THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR

TORT

* (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
* THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

$0penBSD: LICENCE,v 1.19 2004/08/30 09:18:08 markus Exp $
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Open NFC

Copyright (c) 2007-2010 Inside Secure, All Rights Reserved.

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an
"AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied.

See the License for the specific language governing permissions and limitations under the License.
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linux_libnfc-nci

The original Work has been changed by NXP Semiconductors.

Copyright (C) 2015 NXP Semiconductors

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an
"AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied.

See the License for the specific language governing permissions and limitations under the License.
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Lua

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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USB Host Driver (in FreeBSD)

Copyright (c) 1992-2013 The FreeBSD Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS TAS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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mDNSResponder

Copyright (c) 2002-2013 Apple Computer, Inc. All rights reserved.

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS
IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied.

See the License for the specific language governing permissions and limitations under the License.
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wpa_supplicant and hostapd
Copyright (c) 2002-2014, Jouni Malinen <j@w1.fi> and contributors All Rights Reserved.
These programs are licensed under the BSD license (the one with advertisement clause removed).

If you are submitting changes to the project, please see CONTRIBUTIONS file for more instructions.

This package may include either wpa_supplicant, hostapd, or both. See README file respective subdirectories
(wpa_supplicant/README or hostapd/README) for more details.

Source code files were moved around in v0.6.x releases and compared to earlier releases, the programs are now built
by first going to a subdirectory (wpa_supplicant or hostapd) and creating build configuration (.config) and running 'make’
there (for Linux/BSD/cygwin builds).

License

This software may be distributed, used, and modified under the terms of BSD license:

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name(s) of the above-listed copyright holder(s) nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS

"AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR

A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT

OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT

LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE

OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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T-Kernel

This Product uses the Source Code of T-Kernel under T-License 2.0 granted by the T-Engine Forum (www.tengine. org)
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